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About This Book

This guide provides a detailed description of Freescale’s Embedded Bootloader and describes how to port
Freescale’s Embedded Bootloader to a specific PCB/target..

The Embedded Bootloader is intended for use with the IEEE® 802.15.4 evaluation kits (EVK). However,
it is possible to upload applications with the Embedded Bootloader in the development phase, but the
Embedded Bootloader will not provide any debug functions.

The Embedded Bootloader provides an easy and inexpensive way to upload new firmware and eliminate
the requirements for expensive debug/development tools. The only requirement is a standard PC with an
RS232 UART/USB interface running Windows 2000 or XP.

The Embedded Bootloader must be used with the Zigbee Flash Tool which can be found in the Test Tool
Suite ‘Test Tool.exe’.

This document describes Embedded Bootloader version 5.01.

Audience

This document is intended for application developers.

Organization

This document is organized into eight chapters and one appendix.

Chapter 1 Embedded Bootloader Description — This chapter gives an overview of the
Embedded Bootloader.

Chapter 2 Using the Embedded Bootloader — This chapter describes the basic
functionality of the Embedded Bootloader.

Chapter 3 Test Tool, Zigbee Flash Tool — This chapter describes the Zigbee Flash Tool.
The GUI and Command Line versions are covered.

Chapter 4 Programming the Embedded Bootloader — This chapter describes how to
program the Embedded Bootloader to flash memory.

Chapter 5 Application Integration Reference Guide — This chapter describes the
deliverables required to build an 802.15.4/Zigbee Application with the
Embedded Bootloader.

Chapter 6 Port Integration Reference Guide — This chapter describes the deliverables

required and how to integrate them to make an executable Embedded
Bootloader for a specific PCB.

Chapter 7 Embedded Bootloader Public Function Description — This chapter provides
a description of the, from an 802.15.4/Zigbee application, accessible functions
in the Embedded Bootloader.

Chapter 8 Memory Map — This chapter describes the Bootloader Memory Map.

Appendix A Release Folder and File Structure — This appendix shows the folder and file
structure for this release.
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Conventions
This document uses the following notational conventions:

*  Courier monospaced type indicates commands, command parameters, code examples,
expressions, data types, and directives.

» Italic type indicates replaceable command parameters.

*  All source code examples are in C.

Definitions, Acronyms, and Abbreviations

BDM debugger A debugger using the BDM interface for communication with the MCU. An
example is the P&E BDM Multilink debugger for HCSO0S.

BDM Background Debug Module

EVB Evaluation Boards - this term covers the DIG-528-2 (EVK) and DIG536-2
(SARD) boards.

EVK Evaluation Kit

GUI Graphical User Interface

MAC Medium Access Control

MCU MicroController Unit

NVM None-Volatile Memory

PC Personal Computer

PCB Printed Circuit Board

S19 ‘S19’ is the file extension used for the Motorola binary image format. The S19

file encapsulates the binary image as a list of ASCII records. Each record
contains a length -, address -, data - and checksum field. The 16 bit address field
allows a memory space for up to 64 KB. The S19 can be generated with
Metroworks Codewarrior IDE and is the product from the linking process. S19
does not contain additional information to a debugger (where to look for source

files).
Safe Mode Boot The Embedded Bootloader boots up using safe default system values.
HIWAVE P&E HCSO08 debugger GUI.
CPROG P&E HCSO08 flash programming tool called from HIWAVE. The tool is also

available in a command line version where scripts can be made.
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Chapter 1
Embedded Bootloader Description

The Embedded Bootloader is intended for use with the IEEE® 802.15.4 evaluation kits (EVK). However,
it is possible to upload applications with the Embedded Bootloader in the development phase, but the
Embedded Bootloader will not provide any debug functions.

The Embedded Bootloader provides an easy and inexpensive way to upload new firmware and eliminate
the requirements for expensive debug/development tools. The only requirement is a standard PC with an
RS232 UART/USB" interface running Windows 2000 or XP.

The Embedded Bootloader must be used with the Zigbee Flash Tool which can be found in the Test Tool
Suite ‘Test Tool.exe’.

This document describes Embedded Bootloader version 5.01.

The Embedded Bootloader is located in a protected 4 KB flash block in the highest memory area
(0xF000-0xFFFF) of the Freescale MC908HCS08GB60/GT60 microcontroller. (It cannot be accidentally
erased.) A BDM debugger is required to erase the Embedded Bootloader. See the Handling MAC Address
Erasure Application Note, AN2825/D

D At least one of these communication interfaces must be supported by the target PCB.

1.1 Target
The Embedded Bootloader runs on the Freescale MC908HCS08GB60/GT60 MCU.

The MC908HCS08GB60/GT60 is a member of Freescale’s low-cost, high-performance HCSO08 family. It
has 60 KB embedded flash (flash sector size of 512 bytes) and 4 KB embedded RAM..

The Embedded Bootloader uses the MC13192 CLKO. See Chapter 2 for more information.
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1.1.1 Ported Targets

The Embedded Bootloader must be ported (I/O mapped) to a specific PCB for proper functionality and is

currently ported to the following Freescale PCBs:

Axiom AXM-0308:

¢ PC Communication Interface:

e Safe Mode Boot

e Version Number

DIG528-2 EVK

¢ PC Communication Interface:

e Safe Mode Boot

e Version Number

DIG536-2 SARD

¢ PC Communication Interface:

* Safe Mode Boot

e Version Number

¢ PC Communication Interface:

e Safe Mode Boot

e  Version Number

RS232/UART on COM1 (SCI1)/
RS232/UART on COM2 (SCI2)

Short pins 2-3 on COM1 (SCI1)/
COM2 (SCI2)

“AX-0308 Ver 5.01”

RS232/UART on COMI (SCI1)/
USB (SCI2)

Short pins 2-3 on COM1-port (SCI1)
“528&536 Ver 5.01”

RS232/UART on COM1 (SCI1)
Short pins 2-3 on COM1-port (SCI1)
“528&536 Ver 5.01”

RS232/UART/USB on COM1 (SCI1)/
RS232/UART/USB on COM2 (SCI2)

Short pins 2-3 on COM1 (SCI1)/
COM2 (SCI2)

“RD01 Ver5.01”

NOTE

The generic RDO1 target can be used with any PCB using the Freescale
Reference Design version 01 I/O layout. The PCB must support at least
one communication interface. If a USB is the only interface, use a
jumper to short SCI pins 2 and 3 to make Safe Mode Boot available.

Refer to Section 6.3 for details on how to port the Embedded Bootloader to a specific PCB.
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1.2 Features
The following features are supported:

1.3

Upload firmware (802.15.4/Zigbee application) in Motorola S19 record format through
UART/USB. The S1 data record length must be set to 32 bytes

Auto-Detection of the PC communication interface (see Section 1.1.1, Ported Targets).
Initialize memory including stack of uploaded firmware

Initialize the system clock. Self clocked mode and MC13192 clock setup. Power save mode
supported

Run time update/change of the NVM

NOTE

See the Freescale 802.15.4 MAC/PHY Software Reference Manual,
802154MPSRM/D, for a detailed description on NVM layout and values.

Benefits

Users do not have to buy expensive third party debug/development tools to get started.

Users can update the 802.15.4/Zigbee application firmware without having to build in additional
code for interfacing to the Embedded Bootloader (See Section 2.1.3, Safe Mode Boot).

Application firmware can be updated after production by users. However, this requires that the
final product has a communication interface (UART/USB).

Users can update the 802.15.4/Zigbee application firmware even when it is malfunctioning (See
Section 2.1.3, Safe Mode Boot).

The 802.15.4/Zigbee application firmware does not have to include initializing or flash
programming code and can thereby minimize code size.

Can update any NVM data specified by the 802.15.4/Zigbee application.

1.4 Potential Issues

Uses 4 KB of flash (~6.7 % on a MC908HCS08GB60/GT60) and 93 bytes of RAM
(~2,3 % on a MC908HCS08GB60/GT60)

Extended power/boot up time (~17ms) because the Embedded Bootloader must detect the
presence of an application.
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1.4.1 Optional Firmware Upload Settings
»  Skip flash erase

0 Disabled The 802.15.4/Application/NVM (except production data section) is erased
(default)

0 Enabled The 802.15.4/Application/NVM is NOT erased

* Erase production data (get production data from firmware file)

0 Disabled The production data section (with MAC address) in NVM are preserved. All

other NVM values are updated with the values from the S19 record file
(default)

0 Enabled The production data (with MAC address) and all other values in NVM are
erased. All NVM values are updated with the values from the S19 record file

NOTE

Care must be taken when enabling this option. The user must save a
backup of vital production data (MAC address). The production data can
be manually added to the NVM structure in the NV_Data.c file.

* Do not reset after upload
0 Disabled The system is automatically reset after upload (default)

0 Enabled The system must be manually reset by user

»  Skip firmware checksum verification
0 Disabled A checksum verification of the S19 file data record is performed * (default).
NOTE

The Embedded Bootloader will report the address of the first data
mismatch found in the current S19 data record. System must be reset if
an error is reported. Check the optional settings and try again.

0 Enabled No checksum verification is performed. Flash programming errors cannot be
detected.

? The UART/USB communication channel is also protected with a protocol checksum.
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Chapter 2
Using the Embedded Bootloader

This chapter describes the Embedded Bootloader functionality. A detailed description of the functions
briefly mentioned in this chapter can be found in Chapter 7.

2.1 Upload Firmware

The Embedded Bootloader can be used in different system configurations depending on the PCB and the
application. The application should have a user interface feature that makes it possible for the application
to call the Enable Download Firmware() function:

The application can optionally call the Hard Reset() function to perform a reset, or the board can be reset
manually. The board will now start up in Embedded Bootloader mode.

Start the PC-Tool. See Chapter 3 for more information.

2.1.1 Use Case One

In this case, users send a specific command via the UART to enable firmware upload

MC908HCS08GB60"/MC13192 PC

B Application Test Tool

(6]

0 NVM

t

1 802.15.4 MAC

(6]

d 802.15.4 PHY

e RS232

r | Device Driver| UART®? B > UART or USB
Y Or MC908HCS08GT60
?0r USB

Figure 1 Application Supporting RS232 UART or USB Interface
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2.1.2 Use Case Two
In this use case, users push a button on the board to enable firmware upload.
MC908HCS08GB60"/MC13192

B Application

0

0 NVM

t

1 802.15.4 MAC

0

User Interface

d 802.15.4 PHY Push Buttons

e /O

r | Device Driver| GPIO [« » S101 | S102 | S103 [S104
" Or MC908HCS08GT60

Figure 2 Application Supporting an I/O Interface

2.1.3 Safe Mode Boot

The Safe Mode Boot Mode is a special startup mode where the Embedded Bootloader boots using safe
system settings thereby resetting the system to a known (default) state.

The Safe Mode Boot can be used to disable the detection of an invalid/malfunctioning application due to
items such as code errors, corrupt NVM data, or internal flash programming errors among others. All the
NVM memory (except production data and MAC address) is completely erased.

The Safe Mode Boot can also be used to upload firmware without first calling the
Enable Download Firmware() function. This could be useful if the use cases (as shown in Section 2.1,
Upload Firmware) are not applicable.

Users must perform the following steps to conduct a Safe Mode Boot.
1. Power off the board
2. Disconnect RS232 UART cable (if the RS232 UART interface is used)

3. Short UART TX and RX (pin 2-3) (This works even though the 802.15.4/Zigbee application does not
use the UART interface.)

4. Power up again. All LEDs are off.
5. Wait until LED1 goes on (< 1 second)
6. Power off the board
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7. Remove short from UART TX and RX and connect UART cable again (if the RS232 UART interface
is used)

8. Power up again
9. Embedded Bootloader is ready to receive new firmware (all LEDs on)

10. Start the PC-Tool. See Chapter 3, for more information.

NOTE

The Safe Mode Boot description is only valid for the Freescale ported
versions of the Embedded Bootloader. Refer to the 802.15.4 Embedded
Bootloader Reference Manual, 802154EBRM/D, for more details about a
specific port of the Embedded Bootloader.

2.2 Updating Non-volatile Memory (NVM)
The following steps show how to update the NVM data from an application (code).
1. The Embedded Bootloader must be present on the board.
NOTE

All EVBs are shipped with the Embedded Bootloader pre-programmed
in flash. The Embedded Bootloader can only be erased/programmed with
a BDM debugger.

2. Call the Update. NV_RAM() function. This function can change any NVM data.

2.2.1 An Example of How to Change the MAC Address

The following code shows an example of how to change the MAC address.

Updat e_ NV_RAM &( NV_RAM pt r->MAC _Address) [ 0], &pPacket[ DATA | NDEX], 8);
NOTE
pPacket — contains the new MAC address.

Any NVM data can in code be read as a normal construct. For example,
use the NV_RAM ptr to get access to individual data.
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2.3 System Bus Frequency

The MC908HCS08GB60/GT60 starts in 4 MHz self clocked mode. The init code changes this to 8 MHz
after a few instructions from reset.

If NVM data is found, the system clock (MC908HCS08GB60/GT60 ICG module and MC13192 CLKO)
and other options are setup as specified by the uploaded application. See the Freescale 802.15.4
MAC/PHY Software Reference Manual, 802154MPSRM/D, for more details.

If no NVM data can be found, the following (safe mode boot) values are used:

* MCI13192 CLKO = 62.5 KHz
MC908HCS08GB60/GT60 bus clock = 16 MHz

2.4 UART Baud Rate

If NVM data is found, the UART baud rate is setup as specified by the uploaded application. Several
values can be used. See the MCO908HCS08GB60/GT60 MCU Data Sheet, MC9S08GB60/D for more

information.

The baud rate depends on the NVM values specified by the application. See the Freescale 802.15.4
MAC/PHY Software Reference Manual, 802154MPSRM/D, for more details.

If no NVM data is found, the following (safe mode boot) values are used:

*  UART baud rate 19200 kbps, 8 data, 1 start, 1 stop, none parity.
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Chapter 3
Test Tool — Zigbee Flash Tool

The Zigbee flash tool is a part of the general Zigbee Test Tool. This chapter provides a brief description
of how to use the Zigbee Test Tool to upload new firmware. For more details about installation and other
features, see the documentation for the Zigbee Test Tool and the Zigbee.hlp file in Test Tool installation
directory .\help.

The flash programming part of the Test Tool can be used with two different user interfaces.
1. The GUI-version in ‘Test Tool.exe’
2. The command line version in ‘Bootloader.exe’ in the ‘S19’ folder.

This description covers Embedded Bootloader version 5.00 of the Zigbee Test Tool.

Uploadable applications in Motorola S19 file format must be copied to the
[installation directory]\Freescale\Test Tool\S19 directory in advance.
Copy any new applications in S19 format to this folder.

NOTE

The actual window layout may differ from the figures shown in this
document. Refer to the Freescale Zigbee/802.15.4 web page for new or
updated applications.
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3.1 Graphical User Interface (GUI) Version

To use the GUI version of the Test Tool, execute the following file:
[installation directory]\Freescal e\ Test Tool\Test Tool.exe

3.1.1 Using the Tools Menu Option

After clicking on the Tools menu option, click the Communication Settings option to choose the baud rate
specified for the current embedded application.

Notice that applications require that you push one or more buttons or some other functions to enable
upload of new firmware. See the Zighee/802.15.4 Evaluation Kit Quick Start Guide, AN2772/D, for a
description of what to do for a specific application.

If no application is downloaded, use the default settings specified for the Embedded Bootloader. See
Chapter 2 for more information.

Use the Add... buttons. Click “Close”.

Tools Menu Baud Selection
Buttons Add Buttons Close Button

Fili Test Tool

File Wiew Tools ‘Window Help

List of Devices

Mame | Location | Type | Add Intemal...l

ZigBee: COM2 [15200] 10000 ZigBee Device
ZigBee: COME [13200] 10001 ZigBee Device Add Extemal..

Remove

[ avefUown

Figure 3 Tools Menu Selection
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3.1.2 Using the View Menu Option

After clicking the View menu option, select port COMx and click “OK”. Choose the baud rate specified
for the current embedded application. See the Zigbee/802.15.4 Evaluation Kit Quick Start Guide,
AN2772/D, for a description of what to do for a specific application.

If no application is uploaded, you must use the default settings specified for the Embedded Bootloader.
See Chapter 2 for more information.

NOTE

If the USB interface is used, the USB option appears as a new COM port.

iTest Tool - Embedded Bootloader - [Embedded Bootloader]
I File Wew Tools ‘Window Help

=10l x|
=17 x|

File Tools Help

r— Optional Firmware upload settings.
™ Skip flash erase
™ Erase production data [oet production data from fimware: file)
™ Dot reset after uplnad

I~ Skip fimware checksum verification

Flash Section:

Upload |
Nv-BéM Info |

Upload progress:

Application Files

EVK_PTC_Dema_w_Freel oader
EVK_PTC_Demo_w_Freeloader_104
EVK_PTC_Dema w Freeloader_104_ 115200
EVK_PTC_Demo_w_Freeloader_104_14_24_15200
EVK_PTC_Demo_w_Freeloader_104_16_78_19200
EVK_PTC_Dema w Freeloader_anden_clock.

EVK_PTC_Demo_w_Freeloader_chk_feil 0x11BF
EVK_PTC_Demao_w_Freeloader_chk_fsil_0x380B

EVK_PTC_Dema_w Freeloader_chk_fel Mk
EVK_PTC_Demo_w_Freeloader_with_prod_data
EVK_Switch_Demo_w_Freeloader
EWEK_Switch_Demo_w_Freeloadsr 104
EVEK_Switch_Demo_w_Freel oader_104_max_power
PTC_Dema

PTC Demo select Device

SARD_Accelerometer_W2

SARD_Accelerometer_W2
SMAC_Accelerometer W2 test_update_wersion
Switch_Demo

Switch_Demo

Name

| Location

| Tupe

ZigBee: COM2 [19200]
ZigBee: COME [19200]
Zighee: COME [19200]
ZigBee: COME [115200]
ZigBee: COME [115200]
Zighee: COMZ [115200]

4

10000
10001
10002
10003
10004
10005

ZigBee Device
ZigBee Device
ZigBee Device
ZigBee Device
ZigBee Device
ZigBee Device

Cancel

teady

[

Figure 4 View Menu Option
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3.1.3 Selecting the Firmware File to Upload

In the ‘Flash Section’ window, click on the application file to upload and then click on the “Upload”
button. The upload progress bar begins to indicate upload progress.

Upload Application
Upload Button Progress Field Files

E:i:hest Tool - Embedded Bootloader - [Ernbedded Bootloader - ZigBee: COMZ2 [19200]] - | m] ll
1 Hle View Tools Window Help == x|
File: ’Tgols Help
r— Optional Firmware upload settings: [ /
Skip flash erase
Erage production data [get production data from firmware fils)
Do ot reset after upload
Skip fimware checksum verificatio
Jash Section: l
Upload | Application Files | | |
EVE_PTC_Demg_w_Freeloader
Hy-Rad |nf°| EVK_PTC_Demp_w_Freeloader_104
EVK_PTC_Deno_w_Freeloader_104_115200
EVE_PTC Demao_w Freeloader 104 14_24_1§200
EVK_PTC_Defno_w_Freeloader_104_16_78_1§200
EVK_PTC_Dgmao_w_Freeloader_anden_clock
EVK_PTC_Dpmao_w_FreelLoader_chl_fej_O«118F
EVK_PTC_[femo_w_Freeloader_chk_fej| Ox38(8
EVK_PTC_Demo_w_Freeloader_chhk_Ffej_Mvi
EVK_PTC_Demao_w_Freeloader_with_prod_dath
EVE_Switgh_Demo_w_FreeLoader
EVE_Switgh_Demo_w_FreeLoader_104
EVK_Switch_Demo_w_Freeloader_104_mas_pfuwer
PTC_Degio
PTC_Defno
SARD_fccelerometer W2
SARD_fccelerometer V2
SMALC [Accelerometer_V2_test_update_version
Switch_Demo
Switch_Dema
Upload progress: |
[
Re’\ UM 4

Status/Error
Information Field

Figure 5 Firmware Upload

The Status/Error Information Field shows the Status/Error Information received from the Embedded
Bootloader.
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After a successful upload of the firmware, the window appears as shown in Figure 6.

NOTE

A system reset is performed (default) after upload as shown in Figure 6.

Automatic Reset
Enabled

est Tool - Embedded Bootloader - [Embedded Bootloader - ZigBee: COM2 [19200]]
1 File View Tools Window Help

File Tools Help /
|

=lolx|
=181

r— Optional Firmware upload settings:
[~ Skip flash erase
[~ Erase produstion data [get produgtion data from fimware file)
[~ Do not reget after upload
[~ Skip fimware checksum verificgtion

 Flash Section: I

Upload |

E/H ._D2mo_w_Freel oader
EVK_PTC_[Jemao_w_FreeLoader

EVK_PTO_Demo_w_Freeloader_anden_clock
EVE_PTE_Demo_w_Freeloader_chk_fej_Ox11BF
EVK_PT
EVE_P

SARD_Accelerometer_V2
SARD_Accelerometer_V2
ShBC_Accelerometer_V2_test_update_version
Switch_Dema

Upload progrgss: |

|Firrmweare downloaded - resets system.

Ready [ Mo v

Figure 6 After a Successful Firmware Upload

NOTE

If the uploaded application uses another baud rate, it is required to
change baud rate values in order to be able to communicate with the
board.
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3.1.4 Using the Help Menu
Click on the Embedded Bootloader About box to see the Embedded Bootloader sub version number.

About Embedded Bootloader x|

Embedded Boatloader Yerzion 5.00

Copynght [C] 2004
F5S EB. 5285536 Ver 5.01 Build: Sep 22 2004 03:38:40

Figure 7 Embedded Bootloader Tool Version

NOTE

The last line is reported from the Embedded Bootloader on the PCB.
This version number is only sent to the PC from power up (not on
reset).

3.1.5 Changing the NVM Data in Flash or File

If users click on an application in the list, it displays the NVM values in the selected application file. If
the uploaded application supports NVM dump, it is possible to read the NVM from the board.

The NVM data can be changed in two different ways:

1. If the uploaded application does not support NVM data editing it is possible to edit the NVM data
in the application file before it is uploaded to the board and save it back in the application file for
later upload.

2. If the uploaded application does support NVM data editing it is possible to edit the NVM data
after the board has been uploaded with the application. For example, the file contains default
values. The Freescale EVK PTC application supports this feature.

NOTE

No production specific information is available in this example window.

Use caution when editing the clock related configuration values. The
values must match each other. There is no sanity check on the user
entered values, though there is a check on length. See the
MCO908HC08GB60/GT60 MCU Data Sheet, MC9S08GB60/D about
how to specify valid register values for the HCS0S.
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Flazh_File_1

Copyright:
Firrmare Label:
MAC Yersion:

PH'" Werzion:
T arget Yersion:

Bootloader ersion:

MY -Fdsh W ersion:

FCL M anufacture;
FCL Wersion:

— Syztern Configuration [nformation

[c] Copyright 2004 Freescale Inc. &l rights rezerved

DE Label: MOGOLLON TAPEATS D18 Yer 1.01
MAC FFDDP Yer 1.01 Build: Jun 28 2004 13:33:49
PHY sl Wer 1.01 Build: Jun 28 2004 193:32:06
PTC Dema %er 0.99 Build: Jul 01 2004 17:21:18

-
-
0001 e o
™
g:gg Application Specific Section > > |

Abel HF Calibration:

— Clock Related Configuration Yalues

System Bus Frequency:

Abel Clock Out Setting:

—MAC Addrezs & Funchional Values

—IDC Module
ICGCT:

ICGCZ:

—5Self Clocked Filter Y alue

0210 = MALC Address: |EI:-:FFFFFFFFFFFFFFFF
0x3645 = Antenna Select: ID:-:DU 3:
Os327d = Sleep Mode Enable:; IEI:-:EIEI 3:
0413 = — Produchion Specific |nformation
0=20 = Hi! Mame Revizion: I
Sernial Mumber: IEI:-:I-I-I-I-I-I-I-I-I-I-I—I-I-I-I—I-I-I-I—I-

ICGFLTL:
ICGFLTL:

w02 <= Production Site:

IEI:-:FF 3:

Contry Code:

—UART Baud Rate

SCNEDH:
SCNEBDL:

99 99 73 73

0x00 =
0x34 =

Production ‘Week Code; ID:-:FF 3:
IEI:-:FF 3:

Production v'ear Code;

Load from NV-HﬁMl Save to NY-FaM |

Load from File |

Save to File

Figure 8 System Configuration Window
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3.2 Command Line Version (CMD)

The command line version of the Embedded Bootloader flash programming tool must be called with
parameters:

Execute ‘Bootloader.exe’ without parameters to show a parameter list:

WINDOWS system32' cmd.exe

C:“Program Files“Freescale“Test Tool-s1l?>Bootloader
Embedded Bootloader version 5.88 — Copyright <(C)> 2084

Downloads a 819 Application file down into a ZigBee Device.

Bootloader [drive:lIpathlfilename [ACLIL:lcomportl]l [/BIL:lbaudratell [~/E]
Al [-01 L[r51]

[drive: I[pathlfilename
Specifies drive,. directory. andsor file to download.

#G Uze specified comport (default GOM1>.

comport COML,. COM2...COM256

B Uze specified bauwdrate (default 192880)>.

haudrate ?5,. 11@. 134, 158, 300, AR, 120A, 18600, 2480, 4800, 720A

7608, 14408, 19280, 38408, 57600, 1152680, 128000 or 2380480
+E Skip flash erasze. This is the default. Use ~—E to erasze flash
hefore download.

A0 Erase production data (get production data from firmnuare
file>. This iz the default. Use -0 to NOT erase HU RAM data
when updating firmuware.

A Do not reset after upload. This is the default. Use ~—A to do
automatic resetsboot after firmware download.

8 Skip firmware checksum verification. This iz the default. Use
/=% to Calculate and compare checksum when updating firmware.

C:“Program Files“Freescale~Test Toolwsi9>_

Figure 9 Command Line Version (Parameter List)

3-8 Embedded Bootloader Reference Manual, Rev 0.0 Freescale Semiconductor



3.2.1 Normal Use Example (Default)
Normal use example (default).

”Bootloader EVK PTC Demo.s19 /C:COM?2 /B:19200 /-E /-A /-O /-S”

WINDDWSh system32h cmd.exe

C:“Program Files“FreescaleTest Toolsl1%>Bootloader EUK_PIC_Demo.s19 ~C:COMZ /B:mm
19280 ~—E ~-A ~—0 /-8

Downloading EVEK_PTC_Demo.s1? on COM2 [19208681]

Upload progress: 1808

FreeLoader started .,ul::cessl-‘ully.

Flash erased.

C:“Program Files“Freescale~Test Toolws19>_

Figure 10 Command Line Version (Using Several Options)

NOTE
It is not possible to edit NVM data with the CMD version.

3.2.2 Flash Erase Disabled Example

Flash erase disabled example.

"Bootloader EVK_PTC_Demo.s19 /C:COM2 /B:19200 /E /-A /-O /-S ™
MWINDOWS' system 32 cmd.exe

C:“Program Files“Freescale“Test Tool“s19>Bootloader EUK_FPIC Demo.s19 ~C:COM2 /B:E!
19288 #E ~—A -0 /-5

Down loading EUK PTC Demn.¢19 on GCOMZ [1920@1

Upload progress:

FreeLoader started duccessfully.

Flazh wasz not erased.

Firmware download failed — mismatch found on address=BxEFFE.

512 Data Transfer failed?

Press any key to continue . . .

C:“Program Fileszs“Freescale~Test Tool-s1%9>

Figure 11 Command Line Version (Flash Erase Disable Option)

NOTE

The flash is not erased and a flash programming error is detected at
address OXEFFE. This is the address of the Embedded Bootloader control
flags, which was not erased. The error message is expected.
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Chapter 4
Embedded Bootloader Programming

This chapter describes how to program the Embedded Bootloader with a P&E Multilink for HCS08 BDM
debugger. The Embedded Bootloader is normally downloaded to the PCB where production data is also
written. Users must employ different procedures depending on what needs to be programmed. Users can
program the Embedded Bootloader to an empty (erased) PCB or they can upgrade to a newer version of
the Embedded Bootloader. Follow the procedures in Section 4.1, Programming To An Empty (Erased)
Board if the PCB is empty (erased).

Users must make a copy of the production data section in the NVM (see Section 5.3.5, NV_Data.c and
NV _Data.h) if they need to upgrade the Embedded Bootloader. This can be done either manually or
automatically by a custom made script with the command line version of the CPROG tool. The command
line version is not described further. Follow the procedures as shown in Section 4.2 on how to make a
copy of the production data.

4.1 Programming To An Empty (Erased) Board

This section describes how to program the Embedded Bootloader to an empty (erased) board.

1. Execute the HIWAVE.EXE file from your chosen installation directory. For example,
[installation directory]\Metrowerks\CodeWarrior CW08 V3.0\Prog\

2. From the main window, setup the target by selecting the “Component” menu, then click on “Set
Target”. The “Set Target” window appears as shown in Figure 12.

Set Target x|

Processar
|HCs08

T arget Interface

IF'&E Target Interface

Thiz T arget Interface supportz following hardware:  « Help |
- PEE CYCLOME Interface
- PEE MULTILIME Cable

- PEE POWERDS Interface
- PEE clazz | to clazz Il target hardware types LI

Figure 12 Set Target Window

3. In the “Processor” drop down menu, select HCS08. From the “Target Interface” drop down menu,
select P&E Target Interface, the click on the “OK” button.
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The “Connection Assistant” window appears where you can select the debugger interface connection.
As shown in Figure 13, a USB connection was chosen and the HCSO08 was selected as the CPU type.
Click the “OK” button.

Bl Connection Assistant : O] x|

You have selected to display this dialog on startup. Specify communications
parameters and click OkK.

—Connection port an PC
ILISE'I - PEE HCS12/HCS 08 Multilink, (FE 3101 44] j Refresh List
Cable Detected : Cable Flash Werzion : Add LPT Part
—CPL Type
HCS08 Processor - Autodetect j
MCU Yaoltage: FCL rezet line:
—FRezet Delay
[T Delay after Reset and before communicating to target for I 0 milizeconds [decimal).

[ Show this dialog before attempting to contact target (Othenwise only display an Emar]

Abort

Figure 13 Connection Assistant Window
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4. Click on “Load Application” under the “File” menu to open the “Load Executable File” window.
Specify application file to program in the “Load Executable File” window as shown in Figure 14.
Select “Motorola S-Record (*.s19)” using the “Files of type:” drop down menu. Navigate to the
folder where a copy of the Embedded Bootloader is located. Select the “Embedded Bootloader.s19”
file and click the “Open” button.

Load Executable File 2l
Look in: | ) DIG-528-2_DIG-536-2 x| « & cf E-

= wssver.sce

File name:  |Embedded_Eootinader 519 Open |
Filez aof bype: IMDtDrD|a S-Record [*.57) j Cancel |

— Load Options
f* Load Code + Symbolz:  © Load Symbolz enly £ Load Code only

— Code Yerification Options
* Mone " Firstbytes only € Al bytes " Fead back orly

Figure 14 Load Executable Window
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The Embedded Bootloader is now programmed to the PCB as shown in the Status Window in Figure 15.

Il CPROGOSZ Programmetr - Yersion 1.01 - [Status Window] - |EI|5|

X Abort | Inittge - s presmicro_conn

Copyright 1999 2002 PLE Microcomputer Systems=_ Inc.

CHMD -RE
Initializing. Target has heen RESET and is active.

(MD>CM C:\Program Files\Metrowerks\CodeWarrior (W08 _¥3.0\prog\P&E\9508GB60.58F
Initializing. {Recommended Trim = 589) {(Bus Fregq = 15533EHz) Initialized.
;Programming file for the 68HCS908GB60 processor FLASH block.

;Mersion 1.03

;Copyright 2002 hy PEE Microcomputer Systems, Inc. {(www.pemicro.com)

Fnmming programming scrpt ...

Figure 15 Status Window

5. Remove power and disconnect the BDM cable from the PCB. Next, power up the PCB. The PCB is
now ready to upload an application. See Chapter 2 for details about how to upload an application.
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4.2 Upgrading The Embedded Bootloader

This section describes how to upgrade the Embedded Bootloader to a newer version with the P&E

Multilink BDM debugger.

L.

Execute the HIWAVE.EXE file from your chosen installation directory. For example,

[installation directory]\Metrowerks\CodeWarrior CW08 V3.0\Prog\

From the main window, setup the target by selecting Setup Target, the select the “Component” menu,

and click on “Set Target”. The “Set Target” window appears as shown in Figure 16.

Set Targek EI

Processzor

|HCs08

T arget Interface

IF'&E T arget Interface

Thiz T arget Interface supports following hardware: & Help |
- PEE CvCLOME Interface
- PEE MULTILIMNE, Cable

- PEE POWERDS Interface
- FLE clazz | to class Yl target hardware types j

Figure 16 Set Target Window

3. From the “Processor” drop down menu, select HCS08. From the “Target Interface” drop down menu,

select P&E Target Interface, then click the “OK” button.
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4. The “Connection Assistant” window appears where you can select the debugger interface connection.
As shown in Figure 17, a USB connection was chosen and the HCSO8 was selected as the CPU type.
Click the “OK” button.

Bl Connection Assistant : O] x|

You have selected to display this dialog on startup. Specify communications
parameters and click OkK.

—Connection port an PC
ILISE'I - PEE HCS12/HCS 08 Multilink, (FE 3101 44] j Refresh List
Cable Detected : Cable Flash Werzion : Add LPT Part
—CPL Type
HCS08 Processor - Autodetect j
MCU Yaoltage: FCL rezet line:
—FRezet Delay
[T Delay after Reset and before communicating to target for I 0 milizeconds [decimal).

[ Show this dialog before attempting to contact target (Othenwise only display an Emar]

Abort

Figure 17 Connection Assistant Window
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5. Make a copy of the NVM sector (both NVMO and NVM1) with the production data.
Select the “PEDebug” menu, select “Programming Options”, and then choose “Start Expert Mode
Programmer”. The “Programmer Expert” window appears as shown in Figure 18.

Il PROGOSZ Programmer - Yersion 1.01 o [m] ]

File Device Program Yerify Upload Windows Help

e o|m B4 BT 5]

I Choose Programming Fui = |E||5| I Configuration - |E||5|
BM Blank check module 4| || Module = C:A\Program Files\Metrowerks\CodeWarrior CW08_V3.0\progll
BR Blank check range NOT ACTIVE 519 File = none
EB Erase byte range NOT ACTIVE Base = 1080

EW Erase word range NOT ACTIVE
EM Erase module

PB Program bytes

PW Program words NOT ACTIVE
PH Program module

UH Uerify module

UR Uerify range

UM Upload module

UR Upload range

SS Specify S record

SH Show module

QU Return to Debugger

RE Reset chip

SD Secure Device

UC Verify CRC Checksum =

Un-Secured = Yes

PT Program Trim Ualue |

Wl Status Window i ] |
CMD = CM -]
Initializing. {Recommended Trim = 589} {(Bus Freg = 15533KHz) Initialized.

:Programming file for the 68HCS9086B60 processor FLASH block.

;Wersion 1.03

:Copyright 2002 by P&E Microcomputer Systems, Inc. {(www.pemicro.com)Done. -

Feady |

Figure 18 Programmer Expert Window

6. In the “Programmer Expert” window, click on “UR Upload Range”. The “Start Address” window
appears as shown in Figure 19. Here you specify the start address for the NVM section. Click the
“OK” button. For NVMO use 0x152F and for NVM1 use 0x172F.

Start Address? x|

Start Addrezs?
|1 521

] I Caricel

Figure 19 Start Address Window

7. In the “End Address” window, which looks very similar to the “Start Address” window, specify the
end address for the NVM section and then click the “OK” button. For NVMO use 0x155B and for
NVMI use 0x175B.

Freescale Semiconductor Embedded Bootloader Reference Manual, Rev. 0.0 4-7



8.

10.

11.

As shown in Figure 20, use the S19 window to specify which S19 file to store active NVM data to
and then click the “OK” button. For NVMO use ‘PD NVMO0.s19’ and for NVM1 use
‘PD_ NVM1.s519°.

519 File ? x|

519 File ?

IE:'xtmp'\F'D_N"v"MD.s'IE‘
0Ek. I Cancel

Figure 20 S19 File Window

Close “Programmer Expert” window.

Use the PC tool “Production_Data Converter.exe” to convert the production data in NVM to default
NVM sector NVMO. Copy the “Production_Data Converter.exe” tool to the folder that contains the
PD NVMO0.s19 and PD NVM1.s19 files. Execute the ‘Production_Data Converter.exe’. The output
is an PD_NVM.s19 file containing the production data from the active NVM sector.

NOTE
The “Production_Data_Converter.exe” tool can be found in the EVK release
“EVK_3 0B” in folder .\source\Zigbee EVK\EVK Common\CPROG_Tool\Scripts\

Click on “Load Application” under the “File” menu to open the “Load Executable File” window.
Specify the application file to program using the “Load Executable” window as shown in Figure 21.
Select the “Motorola S-Record (*.s19)”” under “Files of type:”, then navigate to the folder where a
copy of the Embedded Bootloader is located. Select the “Embedded Bootloader.s19” file and click the
“Open” button.

Load Executable File : 2l xl
Lock in: | £ DIG-628-2_DIG636-2 x|« & eF B

Embedded_Bootloader.s19
E‘ WEEWER, SCC

File name:  |Embedded Bootioader.s13 Open |
Files of twpe: |Moturula S-Record [*.2%) j Cancel |

— Load Options
(¢ Load Code + Symbols ¢ Load Symbolz only ¢ Load Code anly

— Code Yerfication O ptiohs
" Naone ™ Firstbytez only € All bytes ™ Read back anly

2

Figure 21 Load Executable File Window
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The Embedded Bootloader is now programmed to the PCB as shown in Figure 22.

Il CPROGOSZ Programmetr - Yersion 1.01 - [Status Window] - |EI|5|
X Abort | Inittge - s presmicro_conn

Copyright 1999 2002 PLE Microcomputer Systems=_ Inc.

CHMD -RE
Initializing. Target has heen RESET and is active.

(MD>CM C:\Program Files\Metrowerks\CodeWarrior (W08 _¥3.0\prog\P&E\9508GB60.58F
Initializing. {Recommended Trim = 589) {(Bus Fregq = 15533EHz) Initialized.
;Programming file for the 68HCS908GB60 processor FLASH block.

;Mersion 1.03

;Copyright 2002 hy PEE Microcomputer Systems, Inc. {(www.pemicro.com)

Famung programmmung soapt ...

Figure 22 Status Window

12. Write NVM production data back by selecting the “PEDebug” menu. Then select “Programming
Options” and “Start Expert Mode Programmer”. Select “SS Specify S-record” and locate the
PD NVM.s19 file built in Step 10. Select the “PM Program Module” option and production data is

written to flash.

13. Remove power and disconnect the BDM cable from PCB. Next, power up the PCB.

The PCB is now ready to upload an application. See Chapter 2 for more information about how to

upload an application.
NOTE

The applications must have the production section in the NVM cleared.
That is, the application image must contain OxFF's in the production data
section of the NVM.
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Chapter 5
Application Integration Reference Guide

This chapter describes the deliverables required to build an 802.15.4/Zigbee Application with the
Embedded Bootloader.

NOTE

The Freescale Switch Demonstration application is available with
complete source code. The Switch Demonsration shows how to make an
802.15.4 application with the Embedded Bootloader. Refer to the Switch
Demonstration Application Note, AN2773, for more details.

5.1 Product Deliverables

To be able to make an application with the Freescale Embedded Bootloader, you need three major
components.

* Embedded Bootloader Image
*  Application Support Files
* Application Linker File

5.1.1 Embedded Bootloader Image

The Embedded Booloader executable image for a specific PCB must exist on the PCB in advance. If not,
it must be downloaded to the PCB with a BDM debugger like the P&E Multilink BDM debugger for
HCSO08. See Section 1.1.1 Ported Targets for more details.

NOTE

Use caution when making an 802.15.4/Zigbee Application with the
Embedded Bootloader. Several versions (different version numbers) exist
with different supported features. Ensure that you do not use a feature
that is not supported by the Embedded Bootloader version on the PCB
and that a version of the Embedded Bootloader is preloaded on the PCB.

5.1.2 Application Support Files

A few application source files must be included in the 802.15.4/Zigbee application for proper interface to
the Embedded Bootloader. See Section 5.3, Application Support Files for more details.
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5.1.3 Application Linker File

The 802.15.4/Zigbee application code must be linked with the following linker file in order to work with
the Embedded Bootloader interface. The linker file specifies fixed data and code segments. See linker file
for more details. Make sure to use the linker file matching the Embedded Bootloader on the PCB:

Pt c_w Enbedded_Boot | oader. ach
NOTE
This file can be used with the MC908HCS08GB60/GT60 MCU.

5.2 Application

This section describes build environment topics and source files necessary to build a working
802.15.4/Zigbee application with the Embedded Bootloader.

5.2.1 Compiler Defines
The following compiler #define must be specified to enable Embedded Bootloader functionality in an
802.15.4/Zigbee application:

#defi ne BOOTLOADER ENABLED

5.2.2 Unreferenced Symbols

The Embedded Bootloader interface variables, NVM, and strings with version numbers, are not
referenced directly from the 802.15.4/Zigbee application code. Because of this, it is required to add
dummy references to these (and other) unreferenced symbols to prevent the linker file from removing the
symbols during optimization. The dummy references can be placed in any reference function, but
Freescale recommends adding them to the main() function.

The following code is an example from a SMAC application main() function:

#i f def BOOTLOADER_ENABLED

i f( (Freescal e_Copyright[0] == 0x00) ||
(Fi rmnar e_Dat abase_Label [ 0] == 0x00) ||
(SMAC Version[0] == 0x00) ||
(SPHY_Version[0] == 0x00) ||
(NV_RAM ptr->Freescal e_Copyright[ 0] == 0x00) ||
(NV_RAMD. MAC Address[ 0] == 0x00) ||
(NV_RAML. MAC Address[ 0] == 0x00) ||
(boot _| oader _control == ((uint8_t)0x00)) ||
(boot | oader _flag == ((uint8_t)0x00))
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/1 Do sonething to aviod that code is renoved by |inker

5.2.3 System Clock Setup

The Embedded Bootloader contains the ICG_Setup() function which is called if the Embedded
Bootloader must start. The Embedded Bootloader sets up the system clock as specified in the NVM
section (ICG) if available. If not a default value is used.

The 802.15.4/Zigbee application must include a system clock setup function. The 802.15.4/Zigbee
application can access the clock setup FL_ICG_Setup() function in the Embedded Bootloader. This
allows the application to save code space for implementing a system clock setup function. Any clock
setting can be setup by specifying the proper ICG register values in the NVM data section.

The 802.15.4/Zigbee application should also have a “lost clock lock” ISR function which calls the
FL _ICG_Setup() function. This function must be added to the ISR vector table.

The following is an example of an ISR function to handle lost lock of clock (CLKO).
_interrupt void FLL_Lost_Lock_ I SR(voi d)
{

/1 Setup 1CG nodul e again to prevent that system hangs forever.
| CGS1 | = 0x01; // Cear FLL lost |ock interrupt

#i f defined BOOTLOADER _ENABLED

FL_1CG Setup(); // Call 1CG Setup()in Enbedded Boot!| oader

#endi f defi ned BOOTLOADER ENABLED

}

5.3 Application Support Files

The 802.15.4/Zigbee application must include some support source code to make an interface to the
Embedded Bootloader application. The needed files are delivered to users who want to use the Embedded
Bootloader in their system.

NOTE

Some of the files are global header files from the 802.15.4 MAC/PHY release.
Look for new or updated application support files at the Freescale
Zigbee/802.15.4 web page.

5.3.1 DigiType.h

This file contains some C-language type definitions used in the source files.

5.3.2 Gb60_io.h

This is an MC908HCS08GB60 MCU interface file. All peripherals embedded in the MCU are listed with
their absolute addresses.
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NOTE
This file can also be used with the MC908HCS08GT60 MCU.

5.3.3 Crt0.c and Crt.h

These files contain the basic initialization code (basic system clock, memory and stack setup). The normal
basic init file(s) (like the start08.c from Metrowerks) is not needed when the Embedded Bootloader is
embedded.

In an 802.15.4/Zigbee application with Embedded Bootloader, these files only contain the _startupdata
structure. The Embedded Bootloader handles all the basic initialization (memory and stack setup) of the
application. That is, the application’s main() function will be the first item called (entry point).

NOTE

Do not include basic initialization (memory and stack setup) when
building an application with the Embedded Bootloader. Place any
necessary initialization function calls in the main() function. Whatever,
the initialization function or only the _startupdata structure is included is
controlled by compiler #defines. See Section 5.2.1, Compiler Defines
Application for more information.
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5.3.4 Embedded_Bootloader.h and Embedded Bootloader.c

These are the interface files for the 802.14.4/Zigbee application. They contain function pointers to
functions accessible in the Embedded Bootloader. These files also contain absolute addresses, which
should not be changed.

Ensure that the two Embedded Bootloader control flags, which control whether the 802.15.4/Zigbee
application starts or not, are included in the 802.15.4/Zigbee application build. See Section 5.2.2 for more
details.

#pragma CONST_SEG APP_BOOTLOADER FLAGS

/1 Default setting for how BootLoader downl oads firmare
const uint8 t boot | oader_control = ALL BI T_ENABLED;
const uint8_t boot | oader_flag = EXECUTE_APPLI CATI ON,

#pragma CONST_SEG DEFAULT

The 802.15.4/Zigbee application must also call the “void BootLoader Interface Init(void)” function to
set up pointers to the Embedded Bootloader accessible function. The function must be called once during
system initialization.

NOTE

In earlier versions, these files were titled “FreeLoader inf.c” and
“FreeLoader_inf.h”. Do mnot wuser the “FreeLoader inf.c” and
“FreeLoader inf.h” files with the Embedded Bootloader.

5.3.5 NV_Data.c and NV_Data.h

The NVM is not a part of the Embedded Bootloader. However, it is advised to make the NVM a part of
the 802.15.4/Zigbee application.

The Embedded Bootloader can use the information in NV memory, but it has default values (safe mode
boot) to cover scenarios where no NV memory is available, that is, the Embedded Bootloader would be
locked to use the default values.

5.3.6 ISR _Vectors.c

The Embedded Bootloader redirects the ISR vector table to 0XxOEFCO, i.e. the 802.15.4/Zigbee application
ISR vector table must be locate at 0xXOEFCO to OXEFFD (see linker file).

The file also contains a reset vector. The reset vector is not used (defined out) when using the Embedded
Bootloader. The system reset vector is in the Embedded Bootloader address space (0OXFFFE). The
Embedded Bootloader has two system variables located where the redirected “reset vector” is locate at
O0xEFFE to OXEFFF. The variables control the startup of the Embedded Bootloader.
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5.3.7 Dummylsr.c

This file contains a dummy ISR function which makes a break if a BDM debugger is attached to the
BDM connector. An illegal instruction reset occurs if no BDM debugger is attached. The function is
added to all unused ISR vectors in the ISR_Vector.c file.

NOTE

Users can change this function to any desired functionality.
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Chapter 6
Port Integration Reference Guide

This chapter describes the Embedded Bootloader source code release deliverables and how to integrate
them to make an executable Embedded Bootloader for a specific PCB.

NOTE

For wuser convenience, several readme.txt files containing more
information are located in various subfolders.

6.1 Embedded Bootloader Build Environment

This chapter describes the Embedded Bootloader build environment. The Embedded Bootloader
application is built under the Metrowerks IDE CodeWarrior Development Studio for Freescale HC08 3.0,
build 030506.

6.1.1 HCS08 Compiler

All Embedded Bootloader source files are compiled with the following compiler and with the ‘Generate
Code for HCS08’ Code Generation option enabled.

Source file: hw_hc08 _conpiler.dll, version 5.0.8.0

Setting: -Cs08 - CswivaxLFO - CswM nLFO - CswM nSLB9999 -Lasm=%. | st -Lasnc=h -
O -Qu -Onf -OnB=alr -OnCstVar -OnPMNC - Or - TELUE - WrsgNu=acdet

6.1.2 HCSO08 Linker
All Embedded Bootloader object files are linked with the following linker to build an executable file.

Source file: hw hc08 linker.dll, version 5.0.8.0
Setting: -B - EnvSRECORD=s19 - EnvTEXTPATH=Zi gbee_Dat a\ Zi gbee_Debug\ -
W5t dout On

The Embedded Bootlaoder MUST be linked with the following linker file.
.\ Enbedded_Boot | oader\ pr M Enbedded_Boot | oader HCS08. ach

Specific allocated code and variables must not be reallocated, but users can add new code and data
segments.

NOTE

The 802.15.4 and Zigbee applications that interface to the Embedded
Bootloader must be linked with the "Ptc w Embedded Bootloader.ach"
file for proper functionality.

6.1.3 HCSO08 LibMaker

The delivered libraries were made with the following libmaker.

Freescale Semiconductor Embedded Bootloader Reference Manual, Rev. 0.0 6-1



Source file: hw hc08 I i bmaker.dll, version 5.0.8.0
Setting: None

6.2 Product Deliverables

The Freescale Embedded Bootloaader consists of four major components. Refer to Appendix A for a
complete list of released files.

6.2.1 Embedded_Bootloader.mcp

This is the Metrowerks Codewarrior mep project file. This file is used to build the release of the
Embedded Bootloader.

NOTE

It is required that you have Metrowerks Codewarrior installed on your PC to build the
Embedded Bootloader.

6.2.2 HCS08_Flash_Lib.Lib

The library contains functions to write to the internal flash of the HCS08 MCU. The library also contains
functions to handle NVM run-time updates.

The flash library version number is found by searching for the ASCII text string “HCSO08 Flash Lib” in
the ‘HCSO8 Flash Lib.Lib’. The version number is only available from flash library version 5.00.

NOTE

The HCSO Flash Lib.Lib can also be included directly in an application
for run-time update of NVM. Refer to the HCSOS8 Flash Application
Note, AN2770/D for more information.

6.2.3 Embedded_Bootloader_Functionality Lib.Lib

The library contains the internal functionality of the Embedded Bootloader. For example, the state
machine which handles the firmware download, the UART drivers, checksum verification functions and
others.

The Embedded Bootloader functionality library version number is found by searching for the ASCII text
string “EB Func Lib” in the ‘Embedded Bootloader Functionality Lib.Lib’ file.

6.2.4 Source Files

This section provides a brief description of the source files. Refer to Appendix A for more details. The
source files described are those which define the PCB interface. For example, the I/O mapping that
connects the MCU and RF chip.

Embedded Bootloader Target.h Specific Embedded Bootloader defines
For example, the Embedded Bootloader version number.
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HW _Init.c Hardware init functions

HW _Init.h Init function prototypes and defines.
Reset Vector.c System reset vector.

main.c Embedded Bootloader main function.

6.3 Porting to a Specific Target
This section provides guidelines on how to port the Embedded Bootloader to a specific PCB/target.

6.3.1 Code and Data Segments

The Embedded Bootloader must be linked with the linker file as specified in Section 6.1.2. Several code
and data segments are listed and must not be changed. Refer to the map file as described in Chapter 8 for
more details.

6.3.2 Standard Libraries

The Embedded Bootloader must include the ansi i s. | i b from Metrowerks for a successful build. The
library is part of the Metrowerks CodeWarrior installation and is located in the following path:

[Install Fol der]\ Metrowerks\ CodeVarrior CA8 V3.0\Ilib\HCO8c\ *. *

6.3.3 Compiler #defines

No compiler #defines are necessary.
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6.4 Source Files

This section describes the source files.

6.4.1 Target.h
The user must define the PCB target specific #defines in the Tar get . h in the

.\ 802. 15. 4_Header s\ Ghdr . file for a successful port.

Example for the Freescale TARGET DIG528 2 and TARGET DIG536 2:

NOTE

Several other #defines are made in the target description in target.h. The
#defines are used by the 802.15.4 MAC/PHY build. The listed #defines
are the ones which must (also) be defined for the Embedded Bootloader:

MC13192 reset pin connection:

#defi ne HWAssert Abel Reset
#def i ne HWDeAsser t Abel Reset

Optional for Safe Mode Boot indicator function (LED pin connections):

#def i
#def i
#def i

#def i
#def i
#def i

#def i
#def i
#def i

#def i
#def i
#def i

ne
ne
ne

ne
ne
ne

ne
ne
ne

ne
ne
ne

LEDION PTDD &= OXFE;
LEDIOFF PTDD | = 0x01;
LED1ITOGGLE PTDD ~= 0x01;

LED2ON PTDD & = OXFD;
LED2OFF PTDD | = 0x02;
LED2TOGGLE PTDD ~ = 0x02;

LED3ON PTDD & = OxF7;
LED3OFF PTDD | = 0x08;
LED3TOGGLE PTDD * = 0x08;

LEDAON PTDD & = OxEF;
LEDACOFF PTDD | 0x10;
LEDATOGGLE PTDD ~ = 0x10;

The MC13192 attention and reset pin (bit) positions:
#define ABEL_ATT PI N (1<<2)
#define ABEL_RESET PIN (1<<4)

HCSO08 port setup macros:

#def i

ne

WSETUP_PORT_A // PTAPE = 0x3C; \

PTCD &= ~0x10;
PTCD | =

/!l Reset = 0;
/] Reset = 1;
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/1 PTADD = 0x00; /1A'l Port A input

#define nBETUP_PORT_B //PTBD = 0x00;\
/1 PTBPE = 0x00;\
// PTBDD = 0x00;
#define nBETUP_PORT_C PTCDD = (ABEL_RESET _PIN | ABEL_ATT_PIN);

Optional for Safe Mode Boot indicator function (LEDs as output):
#defi ne nBETUP_PORT_D PTDPE = 0x00;\
PTDDD = (0x01 | 0x02| 0x08 | 0x10);

6.4.2 Reset_Vector.c

The system reset vector.

NOTE

The application does not have a reset vector. If a reset occurs in an
application, the Embedded Bootloader’s reset vector is called.

6.4.3 Embedded _Bootloader_Target.h

Users must define the following #defines in the Enbedded_Boot | oader _Tar get . h to achieve a
successful port.

Version number of the build:
/1 Version nunber update:

/1 - Big change (interface/main code structure/new feature) Y.xx, increment
Y

/1 - Smal | er change (function code structure/bug fix) x.Yx, increnent Y

/1 - Smal |l change (bug fix) x.xY, increment Y

#def i ne EMBEDDED BOOTLOADER VERSI ON "5.01" // Number used with all PCB/ Targets
NOTE

Use caution if the version number is changed. You should only change
the PCB board number (#defi ne EVMBEDDED BOOTLOADER_TARGET)
to indicate a special PCB version.

Example for the TARGET DIG528 2 and TARGET DIG536 _2:

#if defined TARGET DI G528 2 || defined TARGET DI G636 2
/1 PCB board nunber for rel ease
#def i ne EVMBEDDED BOOTLOADER TARGET "528&536"

/1 Setup port as output where "signal" nust be set/cleared to indicate
saf e node boot

#defi ne SAFE_MODE_PORT_SETUP PTDDD | = 0x01; // Port D bit O
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#define SET_OUTPUT LEDION // Defined in Target.h

#endi f defined TARGET DI Gb28 2 || defined TARGET DI G636 2

6.4.4 HW_Init.h

This file contains prototypes of all the init functions and defines.

6.4.5 HW _Init.c
This file contains some hardware init functions which depend on the PCB layout.
voi d HWReset Abel (voi d) Reset of MC13192 RF chip (do not change)

voi d Saf e_Boot _Modde_I ndi cat or (voi d) Users can change this function so it matches the
functions available for a particular PCB. The
function can also be left empty. Default is a GPIO
pin set low to light an LED.

void HWInit() The init main function.

NOTE
User can add more functions if required for a particular PCB.
Do not change the calling sequence.

6.4.6 main.c
This file contains the Embedded Bootloader main function and the Embedded version number.

voi d mai n(voi d) It calls the hardware init function and then the
Embedded Bootloader state machine. The state
machine never returns.

NOTE
Dummy references are made to the version number strings for the
Embedded Bootloader Functionality Lib and HCSO08 Flash Lib to
place the numbers in the executable image. If the version numbers are
not required, they can be removed by removing the reference to the
version number which frees up more code memory for user code.
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Chapter 7
Embedded Bootloader Public Function Description

This section describes the public functions which the 802.15.4/Zigbee application can call in the
Embedded Bootloader.

7.1 802.15.4/Zigbee Application Accessible Functions

The following functions, located in the Embedded Bootloader, are made accessible for 802.15.4/Zigbee
applications. For example, an 802.15.4/Zigbee application is not required to have programming routines
to store NVM data in flash. A function pointer, for each function of the below listed functions, is defined
in Embedded Bootloader.c:

Enabl e_Downl oad_Fi r mvar e()
Har d_Reset ()

NV_Fl ash_Set up()

Updat e_NV_RAM)

FL_1 CG_Set up()

UART Port_Sel ect ();

The Embedded Bootloader.h file contains function pointer prototypes and must be included in source
files calling these functions. The function pointers are setup to point to functions with the same name in
the Embedded Bootloader.

ext ern Enabl e_Downl oad_Firmnvare_ptr_t Enabl e_Downl oad_Fi r mnar e;
extern Hard_Reset ptr_t Hard_Reset;

extern NV_Flash_Setup ptr_t NV_Fl ash_Set up;

extern Update NV_RAM ptr_t Update_NV_RAM

extern | CG Setup_ptr_t FL_I CG Set up;

extern UART Port_ Select ptr_t UART Port_ Sel ect;

7.1.1 Enable_Download_Firmware
Prototype:

bool t Enabl e_Downl oad_Fi r mvar e
(

uint8 t interface_state,

uint8 t firmare state

)

Description:

The application must call this function to make the system ready for a new firmware download. The
application must provide a way for the user to interact with the system to call this function.
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NOTE

All bits are enabled by default. Bits can only be disabled (erased in flash)
—never enabled. The bits are enabled again by the new firmware.
I nput :

interface_state - The user selectable options. The bel ow val ues shoul d be
OR ed together:

Enbedded Boot | oader control fl ags:
#def i ne NO_BlI T_ENABLED ((ui nt8_t)0x00)

/1 Option: “Skip flash erase”
#def i ne ERASE_FLASH ((uint8_t)0x01)

/1 Option: “Do not reset after upload”
#def i ne BOOT_AFTER_DOWNLCOAD ((uint8_t)0x02)

/1 Option: “Erase production data”
#def i ne KEEP_NV_RAM ((ui nt8_t)0x04)

/1 Option: “Skip firmwvare checksum verification”
#defi ne PERFORM FLASH VERI FI CATI ON ((ui nt8_t)0x08)

NOTE

The Embedded Bootloader control flags correspond to the “optional
firmware upload settings” which can be disabled/enabled in the Zigbee
Flash Tool. See Section 1.4.1, Embedded Bootloader Description for
details.

The value is inverted. To enable the bit mask option, the setting must be
set to 0. To disable the bit mask option, the setting must be set to 1.

Use firmware state — control if Embedded Bootloader or the application must be started.
To enable download, the setting must be = DO_UPDATE _FIRMWARE.
Enbedded Boot | oader boot fl ag:

#def i ne EXECUTE_APPLI CATI ON ((ui nt8_t)0x55)

#def i ne DO_UPDATE_FI RMAARE ((uint8_t)0x00)

#def i ne FLASH _EMPTY ((ui nt8_t)OxFF)
Output:

True - Ready for reset.

False - Something went wrong in changing the state.
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7.1.2 Hard_Reset
Prototype:

voi d Hard_Reset (voi d)
Description:

The application can call this function to make a system reset. The reset is done by executing an illegal
instruction.

Input:
None
Output:

None

7.1.3 Update_NV_RAM
Prototype:
bool _t Updat e_NV_RAM
(
NV_RAM Struct t const *NV_RAM Di stination_ptr,
uint8_t *Source_ptr,
uint 16_t Source_Length
)

Description:

The application can call this function to update any NVM parameter with new values specified in the
input parameters. There is no validation of input parameters.

NOTE

NVM can in code be read as a normal construct.

Input:

NV_RAM Distination_ptr A pointer to current NV RAM data (ex. The MAC address), which must be changed.
Source ptr A pointer to new NVM data, which must be stored.

Source Length The length (number of bytes) of the new NVM data to store.

Output:

True — NVM data stored.

False - Something went wrong (should never happen).
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7.1.4 NV_Flash_Setup

Prototype:
voi d NV_Fl ash_Set up(voi d)

Description:

This function should never be called under normal conditions. However, it should be called if any of the
other Embedded Bootloader functions malfunctions. The function sets up the flash functions (again), i.e.
copies the flash routines to RAM for execution and initialize the HCS08 flash module.

Input:
None
Output

None

7.1.5 FL_ICG_Setup
Prototype:

void FL_I CG Setup(void)
Description:

This function can be called by the application. The function could be automatically called if the external
system clock is unstable/removed (from ISR function) and on power down/up (doze). This requires that
the FL_ICG_Setup is called from an ISR function.

NOTE

Application programmers can make their own system clock setup
function or call this function and just modify the ICG and MC13192
register values in the NVM section.

Input:
None
Output

None
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7.1.6 UART_Port_Select

Prototype:
voi d FL_I CG_Set up
(
uint8 t data_reg_address,
uint8 t status_reg_address

)

Description:

This function can be called when the application has detected the active communication interface if used
by the application. The communication interface can be any of the two SCI-ports (SCI1 or SCI2). When
called with the proper parameters the Embedded Bootloader knows the active communication interface.

Input:

data_reg_address the address of the active SCI port data register (SCI1 = 0x1F or SCI2 = 0x27 )
status_reg_address the address of the active SCI port status 1 register (SCI1 = 0x1C or SCI2 = 0x24)
Output

None
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Chapter 8
Embedded Bootloader Memory Map

Table1l. Zigbee (MC9S08GB60/GT60) 802.15.4 Embedded Bootloader Memory Map

512 Bytes in a physical flash sector

Direct Port Registers

Direct Addressing RAM "Fast
memory"

Sleep variable:
gSeqPowerSaveMode

Embedded Bootloader stack

Unint RAM for init structure
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1 (share)

12 1800 182B 44 High Page Registers High Page Registers (COP,
(COP, Flash etc.) Flash etc.)
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Embedded Bootloader
function ptrs (8 pieces)

lllegal opcode instruction

Flash routines critical code
(copy to RAM)

Embedded Bootloader
version number string

NM = No meaning

127 FFBO FFBF 16 NV Registers NV Registers
127 FFCO FFFD 62 ISR vectors (31 ISR vectors (31 vectors - 25
vectors - 25 implemented)
implemented)
127 FFFE FFFF 2 Reset vector "address | Reset vector "address in
in Bootloader" Bootloader"
65535
Must be = FFFF for
FFFF valid memory map.
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= May be used by Embedded Bootloader. 802.15.4/App.
can reuse this space (overwrite).

= Used by Embedded Bootloader. Data/code which must be located on the specified
address and (must/will) exists when the application is running

= May be used by
802.15.4/App.

= Used by 802.15.4/App. Data/code which must be
located on the specified address

If either the Embedded Bootloader and/or the 802.15.4/App. must not use a particular resource the color
from the "General HCS08 Map and Usage" is kept.

Cursive = fixed register and vectors in flash

Bold = MUST be located on this particular address - DO NOT
CHANGE.

Flash sector 120-127 is block protected and cannot be erased by SW.

Embedded Bootloader

Application
RAM 4096 bytes available
bytes available (not including ISR vectors and
Code 4016 reset vector)
bytes available. Read and written by Embedded Bootloader (2 sectors are used,
NV-RAM 1024 so it occupies 1024 bytes flash).
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Appendix A

Release Folder and File Structure

This appendix describes the folder and file structure for this release.

A.1l. Folder Structure

—— 802.15.4_Headers

L Ghdr

|7 Bin

— Embedded_Bootloader
| — Ax-0308RevC

|
| L —DIG-528-2 DIG-536-2 RDO1

Global headers from the 802.15.4 MAC/PHY Release

When target is built, the output files are stored here.

Freescale’s reference build of the Embedded Bootloader
for the Axiom AXM-0308
development board

DIG-528-2 and DIG-536-2 are Freescale’s reference
build for the DIG-528-2 and DIG-536-2 EVB’s.

RDO1 is Freescale's reference build for all PCB's using
the Freescale Reference Design version 01.

l— Embedded_Bootloader Functionality Lib Embedded Bootloader functionality library

L Hcsos Flash Lib

}*prm

I—S)UI’CGS

(source code not released)

Embedded Bootloader HCS08 flash library
(source code not released)

Linker file

Source code
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A.2. File Structure

This section describes all of the files in the Embedded Bootloader release.

.\ Embedded_Boot | oader

Embedded Bootloader.mcp Metrowerks Codewarrior project file
flash.hwc Hiwave system file
flash.hwl Hiwave system file
flash.ini Hiwave system file

.\ Enbedded_Boot | oader\ 802. 15. 4_Header s\ Chdr

AbelReg.h

AppAsplnterface.h

Debug.h

DigiType.h Defined C data types

Embedded Bootloader.h New interface file to Embedded Bootloader
(after version 5.00)

FreeLoader inf.h Embedded Bootloader interface file (Freeloader)

(before version 5.00)
FunctionalityDefines.h
Gb60 io.h Register mapping for HCS08
hwdrv_hcs08.h
MacPhy.h
NV _Data.h NVM data structure
NwkMaclnterface.h
Phy Spi.h
PhyMacMsg.h
PublicConst.h
Target.h PCB target definition (I/O mapping)
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.\ Enbedded_Boot | oader\ Bi n\ Enbedded_Boot | oader \ AX- 0308RevC

Embedded Bootloader.elf Elf format file

Embedded Bootloader.map Map file

Embedded Bootloader.s19 Freescale S19 file

.\ Embedded_Boot | oader\ Bi n\ Enbedded_Boot | oader\ Dl G 528-2 DI G 536- 2
Embedded Bootloader.elf Elf format file

Embedded Bootloader.map Map file

Embedded Bootloader.s19 Freescale S19 file

.\ Enbedded_Boot | oader\ Bi n\ Enbedded_Boot | oader _Functionality_Lib
Embedded Bootloader Functionality Lib.Lib Functionality library

.\ Enbedded_Boot | oader\ Bi n\ HCS08_Fl ash_Li b
HCS08 Flash Lib.Lib HCSO08 flash library

.\ Enbedded_Boot | oader\ prm
Embedded Bootloader HCS08.ach HCS08 GT60/GB60 linker file

.\ Emrbedded_Boot | oader\ sour ces
Embedded Bootloader Target.h
HW_Init.c

HW_Init.h

Reset Vector.c

main.c
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